
Version 9 Release 1.2
October 2015

IBM Campaign Release Notes

IBM



Note
Before using this information and the product it supports, read the information in “Notices” on page 27.

This edition applies to version 9, release 1, modification 2 of IBMCampaign and to all subsequent releases and
modifications until otherwise indicated in new editions.

© Copyright IBM Corporation 1998, 2015.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.



Contents

Chapter 1. IBM Campaign v9.1.2 system
requirements and compatibility. . . .. 1
Prerequisites for using IBM Campaign . . . . .. 1
IBM Campaign documentation roadmap . . . .. 2

Chapter 2. What's new in IBM Campaign
9.1.2 . . . . . . . . . . . . . . .. 5
IBM Knowledge Center . . . . . . . . . .. 5
Traditional Chinese support . . . . . . . .. 5
Flowchart tab redesign . . . . . . . . . .. 5
IBM Campaign REST API . . . . . . . . .. 5
IBM dashDB as a user data source . . . . . .. 6
HP Vertica as a user data source . . . . . . .. 6
Amazon Redshift as a user data source . . . .. 6
Big data integration using Apache Hive over Hadoop
as user datasource . . . . . . . . . . .. 7
Requirements and restrictions for Hive-based
Hadoop data sources . . . . . . . . . .. 8
Changes to Campaign dataSource configuration
settings for 9.1.2 . . . . . . . . . . . .. 8

Chapter 3. Fixed defects in IBM
Campaign 9.1.2 . . . . . . . . . .. 11

Chapter 4. Known issues in IBM
Campaign 9.1.2 . . . . . . . . . .. 13

Chapter 5. Known limitations in IBM
Campaign 9.1.2 . . . . . . . . . .. 17

Chapter 6. IBM Campaign Reports
Package . . . . . . . . . . . . .. 21

Before you contact IBM technical
support . . . . . . . . . . . . .. 25

Notices . . . . . . . . . . . . .. 27
Trademarks . . . . . . . . . . . . .. 29
Privacy Policy and Terms of Use Considerations .. 29

© Copyright IBM Corp. 1998, 2015 iii



iv IBM Campaign Release Notes v9.1.2



Chapter 1. IBM Campaign v9.1.2 system requirements and
compatibility

IBM®Campaign is part of the IBM EMM suite of products. Campaign version 9.1.2
requires Marketing Platform 9.1.2. You can upgrade to Campaign 9.1.2 (including
eMessage) from version 9.1.x and 9.1.1.x.

Where to find complete system requirement and compatibility
information

For a list of IBM EMM product versions compatible with this product and a list of
third-party requirements for this product, see the Recommended Software
Environments and Minimum System Requirements document. This document is posted
under Detailed System Requirements on the IBM Support Portal website:
(http://support.ibm.com).

You can also access this document by selecting Help > Product documentation
when you are logged in to IBM EMM.

Prerequisites for using IBM Campaign
Before you begin using IBM Campaign, confirm that your environment meets the
following requirements.
v For an improved user experience, use at least a 21" screen.
v For an improved user experience, set your screen resolution to 1600 x 900.

Lower resolutions can result in some information not being properly displayed.
If you use a lower resolution, maximize the browser window to see more
content.

v A mouse is best for navigating in the user interface.
v Do not use the browser controls to navigate. For example, avoid using the Back

and Forward buttons. Instead, use the controls that are in the user interface.
v If pop-up blocker (ad blocker) software is installed on the client machine, IBM

Campaign might not function properly. For best results, disable pop-up blocker
software while running IBM Campaign.

v Ensure that the technical environment meets the minimum system requirements
and the supported platforms.*

v The correct browser and versions must be used.*
v Clear the browser cache after upgrading or applying any fix pack. This only

needs to be done once, after the application is updated.
v If you use Internet Explorer (IE) with IBM Campaign or any module that uses

Campaign flowcharts (eMessage, Contact Optimization, Interact, Distributed
Marketing): To log in multiple times to view side-by-side information, open IE
and log in to IBM EMM. Then select File > New Session in the IE menu bar. In
the new IE browser window, log in to IBM EMM as the same or a different user.

Important: Do not use any other method to open multiple sessions. For
example, do not open a new tab; do not open another browser session from the
Start menu or desktop icon; and do not use File > New Window in IE. These
methods can corrupt information that is shown in the application.
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*For details on the items indicated by an asterisk, see the IBM Enterprise Marketing
Management (EMM) Recommended Software Environments and Minimum System
Requirements.

IBM Campaign documentation roadmap
IBM Campaign provides documentation and help for users, administrators, and
developers.

Table 1. Get up and running

Task Documentation

Find out about new features, known issues, and
limitations

IBM Campaign Release Notes

Learn about the structure of the Campaign
system tables

IBM Campaign System Tables and Data Dictionary

Install or upgrade Campaign One of the following guides:

v IBM Campaign Installation Guide

v IBM Campaign Upgrade Guide

Implement the IBM Cognos® reports provided
with Campaign

IBM EMM Reports Installation and Configuration Guide

Table 2. Configure and use Campaign

Task Documentation

v Adjust configuration and security settings

v Prepare Campaign for users

v Run utilities and perform maintenance

v Learn about integrations

IBM Campaign Administrator's Guide

v Create and deploy marketing campaigns

v Analyze campaign results

IBM Campaign User's Guide

Improve flowchart performance IBM Campaign Tuning Guide

Use Campaign functions IBM Macros for IBM EMM User's Guide

Table 3. Integrate Campaign with other IBM products

Task Documentation

Integrate with IBM eMessage IBM Campaign Installation and Upgrade guides: How to install and
prepare eMessage components in the local environment.

IBM eMessage Startup and Administrator's Guide: How to connect
to the hosted messaging resources.

IBM Campaign Administrator's Guide: How to configure offer
integration.

Integrate with IBM Digital Analytics IBM Campaign Administrator's Guide: How to configure the
integration.

IBM Campaign User's Guide: How to target web analytics
segments in marketing campaigns.

Integrate with IBM SPSS® Modeler Advantage
Marketing Edition

IBM Campaign and IBM SPSS Modeler Advantage Marketing Edition
Integration Guide

Integrate with IBM Marketing Operations IBM Marketing Operations and IBM Campaign Integration Guide
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Table 3. Integrate Campaign with other IBM products (continued)

Task Documentation

Integrate with IBM Opportunity Detect IBM Campaign Administrator's Guide: How to configure the
integration.

IBM Opportunity Detect Administrator's Guide and IBM
Opportunity Detect User's Guide: How to administer and use the
product.

Integrate with IBM Silverpop Engage IBM Campaign and IBM Silverpop Engage Integration Guide

Note: Additional integrations may be available that are not listed in this table. See Product tools and utilities for
IBM Campaign. Also see IBM Solution Engineering Projects.

Table 4. Develop for Campaign

Task Documentation

Use the REST API See the IBM Knowledge Center

Use the SOAP API v IBM Campaign SOAP API Guide

v JavaDocs in devkits\CampaignServicesAPI

Develop Java™ plug-ins or command-line
executables to add validation to Campaign

v IBM Campaign Validation PDK Guide

v JavaDocs in devkits\validation

Table 5. Get help

Task Instructions

Use the IBM Knowledge Center Go to http://www.ibm.com/support/knowledgecenter/
SSCVKV/product_welcome_kc_campaign.dita

Open online help When using the IBM Campaign application:

1. Choose Help > Help for this page to open a context-sensitive
help topic.

2. Click the Show Navigation icon in the help window to
display the full help.

Get PDFs When using the IBM Campaign application:

v Choose Help > Product Documentation to access Campaign
PDFs.

v Choose Help > All IBM EMM Suite Documentation to access
all product PDFs.

v Click the links during the installation process from the IBM
EMM installer.

Get support Go to http://www.ibm.com/ and click Support & downloads to
access the IBM Support Portal.
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Chapter 2. What's new in IBM Campaign 9.1.2

IBM Campaign version 9.1.2 includes a number of new features and changes.

For a list of newly supported and discontinued platforms, see the document
Recommended Software Environments and Minimum System Requirements, which is
posted under Detailed System Requirements on the IBM Support Portal website
(http://support.ibm.com).

IBM Knowledge Center
All product documentation is now available in the IBM Knowledge Center at:

http://www.ibm.com/support/knowledgecenter/

You can browse or search within or across product families to find the topics that
you need. To search within a single product, expand a product family in the Table
of Contents, select a product, then enter your search term. Click the X in the
toolbar to clear the Search Filter. For more information, click the Help icon at the
top right of the toolbar.

Traditional Chinese support
IBM Campaign v9.1.2 supports the Traditional Chinese locale.

Users can also select Traditional Chinese when installing IBM EMM products.

Flowchart tab redesign
IBM Campaign v9.1.2 has the following flowchart tab design change.

If a campaign has many flowcharts, they are displayed in a single row, in a tabbed
interface. Use the icons (First, Previous, Next) to the right of the tabs to navigate
to other flowchart tabs. To see all flowchart tabs, click the Expand icon (+), then
use the Collapse icon (-) to return to the single-row view.

You can use the browser search function (for example, Ctrl+F) to search for a
flowchart tab. You may need to expand the view (+) in order to see the highlighted
search result.

IBM Campaign REST API
IBM Campaign v9.1.2 introduces a REST API for interacting with campaigns,
offers, offer lists, attributes, and target cell objects.

Information about the IBM Campaign REST API is provided in the IBM
Knowledge Center.

IBM Marketing Platform provides the security framework for the API. Choose
Settings > Configuration and use the configuration properties in the IBM
Marketing Platform | Security |API management category.
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IBM dashDB as a user data source
IBM dashDB is supported as a user data source for IBM Campaign v9.1.2.

IBM dashDB is a fully managed cloud data warehousing service that is available
through Cloudant and Bluemix platforms.

IBM dashDB uses the existing DB2Template.xml in IBM Campaign. The dashDB
data structure is similar to IBM DB2 BLU.

HP Vertica as a user data source
HP Vertica is supported as a user data source for IBM Campaign v9.1.2.

Use the existing PostgreSQLTemplate.xml. All basic (standard) data types are
supported. The COPY command is not supported in the current version of this
release.

Amazon Redshift as a user data source
Amazon Redshift is supported as a user data source, using the PostgreSQL ODBC
driver.

Use the newly introduced PostgreSQLTemplate as the data source template in IBM
Campaign.

Amazon Redshift user database with Campaign is supported on Windows and
Linux operating systems only. Amazon Redshift database is not supported for
system tables.

For information about using Amazon Redshift as a data source, see the following
documentation or search the IBM Knowledge Center:

Document Information about Amazon Redshift support

IBM Campaign Release Notes v Changes to IBM Campaign configuration
settings for 9.1.2

v Known issues and limitations

Recommended Software Environments and
Minimum System Requirements

Details about supported versions

IBM Campaign Installation Guide Preparing Amazon Redshift user data sources
for Campaign

IBM Campaign Administrator's Guide v Using Amazon Redshift user data sources
with IBM Campaign

v Supported data types for Amazon Redshift

v Configuration settings for
PostgreSQLTemplate
(Campaign|partitions|partition[n]|
dataSources)
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Big data integration using Apache Hive over Hadoop as user
datasource

Apache Hadoop Hive is supported as a user data source, using either the
Cloudera ODBC Driver for Hive or the DataDirect Apache Hive ODBC driver.

Use the newly introduced BigDataODBCHiveTemplate as the data source
template in IBM Campaign.

Hive-based big data integration with Campaign is supported on the Linux
operating system only. Campaign and Hive-based big data as a user database is
not tested with Campaign installed on MS Windows. Big data Hive-based database
is not supported for system tables.

For information about using Apache Hadoop Hive as a Campaign data source, see
the following documentation or search the IBM Knowledge Center:

Document Information about Hive support

IBM Campaign Release Notes v Requirements and restrictions for
Hive-based Hadoop data sources

v Configuration settings related to Hive
support

v Known issues and limitations related to
Hive support

Recommended Software Environments and
Minimum System Requirements

Details about supported versions.

IBM Campaign Installation Guide v Requirements and restrictions for
Hive-based Hadoop data sources

v Preparing Apache Hadoop Hive user data
sources for Campaign, including installing
and configuring a Hive ODBC driver,
importing and configuring the
BigDataODBHHiveTemplate data source in
Campaign, mapping the Hive data source
in Campaign, and configuring SSH on the
Campaign listener server.

v Overview of the Campaign integration with
Hadoop

v Integration architecture

v Terminology and resources for Hive
Hadoop

IBM Campaign Administrator's Guide v Using Hive-based Hadoop data sources
with Campaign

v Exporting data from Campaign to a
Hive-based Hadoop system

v Hive query language conformance

v Supported data types for Apache Hadoop
Hive

v Configuration settings for
BigDataODBCHiveTemplate
(Campaign|partitions|partition[n]|
dataSources)
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Requirements and restrictions for Hive-based Hadoop data sources
The following requirements and restrictions apply to using Hive-based Hadoop
data sources with IBM Campaign.
v One of the following drivers is required. The customer is responsible for

obtaining the driver.
– DataDirect Apache Hive ODBC driver from Progress.com: DataDirect

Connect64(R) for ODBC Release 7.1.5.
– Cloudera ODBC Driver for Apache Hive Version 2.5.16 for Apache Hadoop

Hive from Cloudera, Inc.
v The following Hadoop distributions are supported, with Apache Hive as the

connection point: Cloudera, Hortonworks, IBM BigInsights ™, MapR.
v Minimum supported Hive version: 0.14
v The integration is currently supported on Linux RHEL 6.3 or higher.
v Hive-based Hadoop is supported as a user data source only. It is not supported

for Campaign system tables.
v The integration does not currently support the IBM Campaign Cube, Optimize,

or Interact List process boxes or eMessage Landing Pages in an Extract process
box.

v You can use a Hive-based Hadoop user data source on an IBM Campaign
system that is integrated with IBM SPSS-MA Marketing Edition and also with an
IBM Campaign and Digital Analytics integration.

Changes to Campaign dataSource configuration settings for 9.1.2
To support Apache Hadoop Hive and Amazon Redshift as user data sources, two
new data source XML templates were added, and related changes were made to
the Campaign|partitions|partition[n]|dataSources|<dataSourcename>
configuration settings.

Two new data source XML templates were added:
v To support Amazon Redshift as a user database: ..Campaign\conf\

PostgreSQLTemplate.xml

v To support Hive-based big data as a user database: ..Campaign\conf\
BigDataODBCHiveTemplate.xml

The following configuration changes are related to the new templates. To access
configuration settings, choose Campaign > Settings and select
Campaign|partitions|partition[n]|dataSources|<dataSourcename>.

For details about configuration settings, see the IBM Campaign Administrator's
Guide.
v A new configuration property called HiveQueryMode was added. This property

is used only for Hive-based Hadoop data sources (BigDataODBCHiveTemplate).
It provides a way to switch between the DataDirect and Cloudera drivers. For
DataDirect, select Native. For Cloudera, select SQL.

v New configuration properties called LoaderPreLoadDataFileCopyCmd and
LoaderPostLoadDataFileRemoveCmd were added. These properties are only for
Hive-based Hadoop data sources (BigDataODBCHiveTemplate). These properties
are used to copy and remove temporary data files as part of the Campaign and
Apache Hive-based Hadoop big data integration.
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v For DateFormat, note the following information if you are using Hive-based
Hadoop big data data sources: All Date strings (Date, DateFormat,
DateTimeFormat, DateTimeOutputFormatString) must use the dash "-" character
to format dates. Hive does not support any other characters for dates. Example:
%Y-%m-%d %H:%M:%S

v Hive-based Hadoop does not support the Tab (/t) character as a
LoaderDelimiter value.

v The LoaderDelimiter value must match the ROW format delimiter that was
used when the big data database table was created. This applies to both Hive
and Amazon Redshift. In the following example, a comma is used:
ROW FORMAT DELIMITED FIELDS TERMINATED BY ’,’ ;"

v The Type property supports two new types for customer tables:
BigDataODBC_Hive and PostgreSQL.

v The UseExceptForMerge property must be FALSE for Hive-based Hadoop big
data. Hive does not support the EXCEPT clause, so a setting of TRUE can result
in process failures.

Chapter 2. What's new in IBM Campaign 9.1.2 9
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Chapter 3. Fixed defects in IBM Campaign 9.1.2

The following defects were fixed in Campaign 9.1.2.

Table 6. Campaign fixed defects

ID Fixed defect

195733 Inferred response tracking is very slow.

193991 Failed flowchart appears twice in monitoring.

193992 Code 11506 while creating OLT table.

193960 OLT table reference in eMessage process box is corrupt after generating a user variable in a flowchart.

193958 User variable node is not displayed in eMesage box after assigning input cell on Source tab.

193948 Stored XSS issue found via manual security testing.

193944 10404 error when opening certain Audience process boxes.

193952 IFRAME injection security issue.

193987 Process box becomes configured in error during some other branch run.

193985 Time to show list of tables is very high: When trying to map a table from database that has 10000 or more
tables in a new flowchart, it takes about 5 to 7 seconds to display table list drop down, but in subsequent
attempts of table mapping to same flowchart from same database it takes more than 25 seconds to display
table list.

193980 Dimension table with campaign name is not seen in Select process.

181861 When using Tivoli Access Manager, request to ico_BatchFlowchrt.gif doesn't use WebSEAL junction, causes
CSRF error when going into edit mode of flowchart.

193947 PO04588 - General tab in Select process box is truncating comments.

195744 A user without "clear contact history" permission could clear the CH table.

193982 Audience levels not in alphabetical order when mapping tables.

193954 Make error message "Field Name contains illegal character" localized for other languages.

193946 Unable to see table relationships when remapping table.

193975 Unable to add more than one key field and click Next when remapping multi-keyed dimension table when
changing 2+ key field names.

193976 Table remapping pop-up warning not appearing when remapping dimension tables.

193979 Changing output database table in Snapshot fails when outputting same-named fields from different tables.

193949 Not possible to use SQL that contains Tab character in pre- and post-processing of Select process.

193989 Scrollbar missing in "Save under" dropdown when creating custom macro in IBM Campaign.

193945 Target cell spreadsheet uses only half of the browser window height.

195742 User can run trigger through flowchart even when "Run Triggers" permission is Denied.

195454 Not able to save the flowchart after removing annotation.

195377 Not able to kill processes unless unica_svradm connect to listener host for a non-clustered setup.

193990 PO05019 - Campaign takes a long time to open Mail List process for configuration.

193951 When UMO_UC_integration is True, eMessage process box cannot be executed due to Error 10164: This
process cannot handle cells from the TCS that are control cells.
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Chapter 4. Known issues in IBM Campaign 9.1.2

Campaign 9.1.2 includes the following known issues.

Table 7. Campaign known issues

ID Known issue

194989 Campaign server process crashed with error 10404 while executing Segment process box.

Workaround: For all Segment process boxes that have Create Extract tables checked:

1. Uncheck the Create Extract tables option in the Segment process box.

2. Add an Extract process box downstream of the Segment process box and use this extract output in
subsequent processes.

195836 Clicking a session flowchart displays the error message "Please wait for the page to load." This issue
occurs in the following specific scenario: If you are in session flowchart edit mode, click Save and Exit
flowchart, navigate to the Session summary page, and then click the flowchart tab again. Workaround:
Navigate to the All sessions page and then visit the flowchart again to open it in view mode.

196761 Chrome/IE11: The Available Fields box overlaps the Use and Profile buttons on the Select process box
and Extract process box in some locales. This issue occurs for all locales other than English and French
on Chrome and IE11 browsers only. This issue does not occur on IE10. Workaround: Resize the Select /
Extract process box to avoid the overlap.

198739 Track and Response process box execution failed with error 10404 and a stack trace was generated
when Use In-DB Optimization was selected under flowchart Advanced Settings.

Workaround: Disable Use In-DB Optimization in the flowchart that contains the Track or Response
process box along with other process boxes. If that is not possible, create a new flowchart and
configure only Select and Track and /or Response in the new flowchart and you can enable Use In-DB
Optimization here.

185658 Big data: Unable to copy data to big data output tables when loader delimiter is "\t"

Hive-based Hadoop big data does not support the Tab (/t) character. Do not use the Tab character as
the LoaderDelimiter value (Campaign|partitions|partition[n]|dataSources|dataSourcename).

194575 Big data: Segment process box execution fails with error when Create Extract Tables option is checked.
Workaround: Extract within Segment can be achieved by placing the Extract process downstream of the
Segment process.

194516 Upgrade: For a listener cluster upgrade from 9.1.1 to 9.1.2, the installer screen to copy files from
Campaign/partition to Listener Shared Home should not appear.

This issue affects upgrading a listener cluster from 9.1.1 to 9.1.2. If the base installation is a Listener
Clustered environment, the Upgrade installer should not show the screen "Move Listener Files to
Shared Network Location" because the listener files are already at the shared network location.
Workaround: Select the Manual radio button on the screen "Move Listener Files to Shared Network
Location" if the base setup is already configured for listener clustering.

NA Big data: The temporary data file upload location on the Hive server must be /tmp.

The property LoaderPreLoadDataFileCopyCmd
(Campaign|partitions|partition[n]|dataSources|dataSourcename) is used for Hive-based Hadoop data
sources (BigDataODBCHiveTemplate). This property uses SCP to copy data from IBM Campaign to a
temp folder on the Hive-based Hadoop system. Currently, the location must be called /tmp. This must
be the file system location, not the HDFS location.

175825 When defaultBehaviorWhenOutputToFile is set to Create New File, it works only when you select a
new output (export) file for the first time. If you try to change the existing output file and select a new
output file, then the option Append to Existing Data gets selected by default. It can be changed
manually to Create New File.
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Table 7. Campaign known issues (continued)

ID Known issue

176876 If you input more than 21 DBCS characters into a User Variable Name, the following error message
occurs: 11532 Length Exceed Error: User Variable Name exceeds 64 characters for UserVar at
location[0]

177300 Extracted fields from a top-level Segment process box are not displayed on the Derived field window
of the Select process box. The Segment process box exported fields should appear under the Extract
node on the Derived field window of the Select process box.

177430 In a Segment process box, segments reshuffle incorrectly after changing Segment by field to Segment
by query. This issue occurs only when fields are sorted repeatedly, several times. It does not occur if
you just perform this action once or twice. When segments are moved up or down and you change
between Segment by query and Segment By field, segments are reshuffled incorrectly. For example,
the query of segment 1 is displayed for segment 3.

147356 Resize_Maillist_Parameter_Assign Value: Drop-down list does not revert to inactive state when user
clicks outside of the drop-down arrow. This issue occurs only on Internet Explorer. It affects
drop-down lists that use a tree selection widget.

164028 Cognos reports do not work with Campaign in French.

You can change the product language for the specific user by setting the product language to match
the language of the application report package. To set the product language, open the Cognos
connection, and under User Preferences set the corresponding product language. You should not
change the content language. If the content language is changed, then the corresponding xpath for the
reports should also be changed.

178526 You can safely ignore the following non-fatal error in the Campaign_Install.log. The error is logged if
you interrupt and then restart the Campaign installation.
"com.unica.install.ia.custom.ManagerReadConfigurationStatus: ERRORAdditional Notes: ERROR - class
com.unica.install.ia.custom.ManagerReadConfiguration NonfatalInstallException The processing
instruction target matching "[xX][mM][lL]" is not allowed."

NA Mail List process box gets unconfigured with error "31606: History table are changed" on Flowchart
run.

1. There is no issue if the history tables are mapped prior to building a flowchart and adding a Mail
List process. 2) If you do not follow step 1, you can still map the history tables after the error appears.
If you edit the flowchart and configure the process box, the process will run.

NA After migrating non-ASCII data to Campaign 8.6, in some cases you cannot open Campaign flowcharts
on the target system. Session flowcharts open successfully. To work around this issue, remigrate the
campaigns in overwrite mode. You can then open the flowcharts.

2968 Hot keys are not implemented on most of the windows. In the Dojo implementation it is not possible
to use keyboard shortcuts to activate certain functions. Instead the user must click buttons.

13460 When the Export to File option is unchecked on the Fulfillment tab of the Mail List process box, the
Summary File option is enabled but should not be.

13502 There should be a way to map DCH from the UI when field name for CH table is changed. There
should be a way to map the UA_DtlContactHistory table after changing a column name in the
UA_ContactHistory table. To map UA_DtlContactHistory, change the source table's column name
accordingly (so the Source Table fields and Required Fields match) and then map the table.

TT
DEF062333

Information related to associated products does not appear in offer on Marketing Operations. When an
offer created in Campaign with products associated with it is imported in Marketing Operations,
information about the associated products is not available in Marketing Operations.

TT
DEF063392

If it was not mapped initially, the Digital Analytics translation table is not available in the Segment
process box. No translation table or any other user table is available in the Segment process box, if the
translation table was not mapped initially.

75262 Clicking "Return to previous page" distorts the UI in some cases. Use the links within the products to
navigate, rather than the browser controls.
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Table 7. Campaign known issues (continued)

ID Known issue

90956 If you open an Extract process configuration dialog and click OK without making any changes, the
message "Process run results will be lost, Continue?" appears. The message should not appear when no
changes have been made.
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Chapter 5. Known limitations in IBM Campaign 9.1.2

Campaign 9.1.2 includes the following known limitations.

Table 8. Campaign known limitations

ID Known limitation

NA Big data: To perform the UPDATE operation on any process boxes in a flowchart, ensure that your HIVE
tables are configured as transactional tables such that they support the ACID property. This is a key
feature introduced in HIVE version 0.14.

190621 Big data: Campaign with Hive big data as a user database does not support user table mapping with Base
and Dimension levels up to the fourth level hierarchy.

If you map a Base record table with four levels of dimension tables in a Select process box, then build a
query based on the fourth level Dimension table, the query fails with Error 11528. This issue should not
affect big data users because multiple dimensions should not be needed. By definition, a big data source
has a large table of records split across Hadoop nodes (such as HDFS).

185854 Big data: Campaign integration with Hadoop-based Hive big data as a user data source is not tested on
MS Windows operating system.

194095 For Redshift database, the error message "Unsupported type timestamps with time zone" is displayed
when exporting data from a Snapshot process box. Timestamp with timezone is an unsupported
PostgreSQL data type on Amazon AWS.

194806 BLU: Snapshot process box execution fails with error when records are exported with option Replace All
Records. The error occurs with BLU DB2 database and only when Replace All Records is selected. It does
not occur for Append to Existing.

NA IBM Interact when configured with IBM WebSphere Application Server: You must configure IBM
WebSphere JVM to use JDK 1.7. When IBM WebSphere Application Server 8.5.5.x is configured with JDK
1.7 and HTTPS communication, you must use IBM JAVA SDK version 7.0.8.10 or higher.

NA Using multiple SQL statements for raw SQL queries is not currently supported on big data user
datasources. For related information, search the IBM Knowledge Center for Hive query language
conformance.

195581 While running a Campaign flowchart, if listener crashes or is stopped, user is not able to access the
running flowchart from the UI. Requests are being served by another node of the cluster but while
accessing the flowchart, a pop-up message says "listener failover occurred..." It may be necessary to restart
the master listener.

196487 DataDirect + Cloudera: Snapshot process box execution fails when some of the output table column fields
are not mapped. This is related to a known issue with the Hive 0.14 database. Workaround: To extract
fewer than the fields in the mapped database table, fill them with derived fields or uservars and fill them
with the default desired values, such as NULL.

184919 Big data: Mail List process execution fails with error: unique constraint
(UCDUC9111.CCONTACTHIST_PK) violated.

Mail List / Call List process box execution completes successfully when User Database table - Audience
Level is BigInt. However:

v When a user profile table contains Audience ID in Decimal format, this error will occur.

v When a user profile table is created by export from File to Database then by default all numeric fields
are created as Decimal.

For big data: The user profile database table audienceID should be of BigInt type when used with DB2
databases. If the user profile database table audienceID is Decimal, the Mail List / Call List process box
execution will have errors.
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Table 8. Campaign known limitations (continued)

ID Known limitation

186489 Big data: "Record exported = Unknown" is displayed on Snapshot process box if cell size Limit is used in
preceding Select process box.

(1) Count of records is unknown when a Snapshot is populated through INSERT INTO SELECT FROM
queries. If you want a record count, map it as Base table, in which case Campaign will compute the record
count. (2) Count of records will be known and updated in case of loader (LOAD DATA) invocation. No
need to map the table.

NA Web application clustering is supported only for stand-alone Campaign (not integrated with other
products). For example, do not configure a clustered web application environment if you currently use
eMessage, Interact, Contact Optimization or Marketing Operations. Only Sticky sessions are supported. No
session replication is done, as the focus is on scalability. Failover is not implemented.

NA Flowchart annotations are not affected by zoom. You cannot resize annotations. Annotations do not appear
in the panning area. Annotations can be moved out of the flowchart window and the only way to access
them is to move the associated process box in the direction of the annotation, then drag the annotation
back to the main flowchart area and move the process box back to its original position. If an annotation
overlaps a process box, drag the annotation to another position.

176377 DB2 10.5 BLU for user DB: No indexing requirement for temp tables in Campaign datasource. DB2 10.5
(with BLU feature ON) does not require indexing in Campaign. Campaign has certain properties for
datasources, such as TempTablePreTruncateRunScript, TempTablePostExecutionSQL, and
PostTempTableCreateRunScript, where you can provide SQL or scripts to create indexes on user database
tables. If you are using DB2 10.5 as a customer database, with the BLU feature ON, you do not need to
configure any of these temp table properties.

NA Dialog behavior: In certain cases, it is necessary to click twice in order to activate a field or change a field
value.

NA The monitorEnabledForEmessage configuration property in Campaign|monitoring is not currently used.

NA Relevant products limitation: When offer management is performed from IBM Marketing Operations, the
"relevant products" functionality, which relates product IDs to offers, is not available.

NA Blank or incorrect results from derived fields in a Mail List process. This can occur in a process box that
uses a derived field that calls a Generated field (UCGF) that changes value.

Do not use a UCGF in a Mail List derived field if the UCGF is not constant. Also, from the Parameters tab,
do not create a derived field to call a UCGF to populate offer attributes.

For details, see the following Tech Note: http://g01zciwas018.ahe.pok.ibm.com/support/dcf/
preview.wss?host=g01zcidbs003.ahe.pok.ibm.com&db=support/swg/istech.nsf
&unid=C4A93DC0ED188D6985257A6B00699C45&taxOC=SSCKNRB&MD=2012/08/31%2015:08:35&sid=

NA Profiling a Campaign Generated Field (UCGF) does not yield correct results. Some UCGFs have a value
according to the cell or the offer being processed. For cell-related UCGFs, only the value associated with
the first cell appears during profiling.

NA The default value for a custom cell attribute does not appear when you open the target cell spreadsheet.
Although the default value is not initially displayed, it will be used. The value can be displayed or
changed by clicking or opening and editing the custom cell attribute in the target cell spreadsheet.

NA The UA_UsrResponseType.Name field cannot contain a left parenthesis followed by a single quote.
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Table 8. Campaign known limitations (continued)

ID Known limitation

NA Use unique TempTablePrefix for each data source when mapping multiple data sources to same physical
database.

If you mapped multiple data sources in Campaign to the same physical database, and you use the same
TempTablePrefix for more than one of the data sources, when you use the cleanup utility to delete
orphaned temp tables, it may falsely identify temp tables as orphaned, when they are in fact legitimate
temp tables defined from a different Campaign data source.

Any deleted temp tables will automatically be recreated when you rerun affected flowcharts, but as a best
practice, use a unique TempTablePrefix for each data source when mapping multiple data sources to the
same physical database.

If the data sources defined in Campaign map to different schemas in the database, another solution is to
ensure that the database user who runs the cleanup utility does not have privileges to drop tables in other
schemas in the same database.

11162 Several dialogs that might not contain a large amount of data or are not commonly used cannot be resized
or maximized.

17202 Error 19024: Cannot delete segment folder if the segment was deleted from the folder. A segment that is
deleted from a folder remains as an inactive segment in the folder. Folders with inactive segments cannot
be deleted. This is working as intended.

18991 If the same flowchart is edited in multiple locales, undesired behavior can occur. This situation occurs only
if two (or more) users with different language settings edit the same flowchart. Users with different locales
should not edit the same flowchart that was created by a user with a different locale since this can lead to
undesired behavior. The preferred approach is to create and edit flowcharts with users having the same
language settings.

84147 Copy and paste behavior in process boxes and other dialogs: For security reasons, some browsers do not
allow applications to copy and paste via the Clipboard. This affects the General tab of the Segment process
configuration and other areas of the application where copy and paste might be used.

161323 The error "Login failed. Error 10553" can occur if you try to log in to the Campaign utilities when the IBM
Marketing Platform | Security | login method is set to Windows integrated login or Web access control.
To avoid this issue, change the login type to LDAP or IBM Marketing Platform prior to using the
Campaign utilities.

201968,
200241

If two process boxes are moved very close together in a flowchart, the direction of the connection arrow
changes. This limitation affects the visual representation of the arrow. The process data flow is not
affected. The workaround is to move the process boxes farther apart so the arrowhead changes back to the
correct direction.
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Chapter 6. IBM Campaign Reports Package

The Campaign Reports Package delivers reporting schemas that you can use to
track campaign, offer, and cell performance. To use the Reports Package, Campaign
must be integrated with IBM Cognos

For more information, see the IBM EMM Reports Installation and Configuration Guide
that is supplied with IBM Marketing Platform.

The IBM Campaign Reports Package contains the following items:
v Schemas that are registered with IBM Marketing Platform during installation.

They describe the attributes and metrics that represent the product's reporting
schema and include:
– Base schemas that are the basis of the reporting schema (with no custom

attributes)
– Custom versions of most of the base schemas that rely on the preconfigured

custom attributes for Campaign
– Templates that you can use to create new schemas

v IBM Cognos customizable model and reports to be deployed on an IBM Cognos
BI Server

v Reference documentation that describes the IBM Cognos model and the reports.
Documentation can be found in the directory ReportsPackCampaign\cognos10\
CampaignDocs.

The Campaign reports retrieve data from one data source: the Campaign system
tables.

Reporting Schemas

The following reporting schemas are provided:
v Campaign Views provides the standard attribute views of the Campaign system

tables (campaign, offer, cell, and so on).
v Campaign Custom Attributes is for reporting on custom attributes of campaigns,

offers, and cells.
v Campaign Performance is used by reports that display performance

measurements starting at the campaign level over all time or various periods of
time (days, months, and so on).

v Offer Performance is used by reports that display performance measurements
starting at the offer level over all time or various periods of time (days, months,
and so on).

v Campaign Offer Response Breakout is used by reports that show campaign and
offer responses based on response types.

v Campaign Offer Contact Status Breakout is used for measurement of campaign
and offer contacts based on contact status.

The custom schemas extend the last five of the listed schemas to include the
default, preconfigured response types, custom attributes, and so on.
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Templates

If you have additional audience levels, you can create additional reporting schemas
for them with the following templates:
v Campaign Views
v Campaign Custom Attributes
v Campaign Performance
v Offer Performance
v Campaign Offer Response Breakout
v Campaign Offer Contact Status Breakout

Reports

The reports package contains Cognos example reports that can be accessed from
the Analytics menu or the Analysis tab for a campaign or offer. Reports can also be
displayed in portlets on the Dashboard.

The following campaign-specific example reports are available from the Campaign
Analysis tab:
v Campaign Detailed Offer Response Breakout
v Campaign Financial Summary by Offer (Actual)
v Campaign Offer Performance by Month
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell with Revenue
v Campaign Performance Summary by Offer
v Campaign Performance Summary by Cell and Offer
v Campaign Performance Summary by Cell and Offer (with Revenue)

The following offer example reports are available from the Offer Analysis tab:
v "What If" Offer Financial Summary
v Offer Performance by Day
v Offer Performance Summary by Campaign

The following cross-object example reports include information about multiple
objects in Campaign. These reports are available from the Campaign Analytics
page.
v "What If" Offer Financial Summary
v Campaign Detailed Offer Response Breakout
v Campaign Financial Summary by Offer (Actual)
v Campaign Offer Performance by Month
v Campaign Performance Comparison
v Campaign Performance Comparison (with Revenue)
v Campaign Performance Comparison by Initiative
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell (with Revenue)
v Campaign Performance Summary by Cell by Initiative
v Campaign Performance Summary by Offer
v Campaign Performance Summary by Offer (with Revenue)
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v Campaign Performance Summary by Cell and Offer
v Campaign Performance Summary by Cell and Offer (with Revenue)
v Campaign Summary
v Offer Campaign Listings
v Offer Performance by Day
v Offer Performance Comparison
v Offer Performance Metrics
v Offer Performance Summary by Campaign

The following campaign-specific example report portlets are available on
dashboard pages:
v Campaign Response Rate Comparison
v Campaign Return on Investment Comparison
v Campaign Revenue Comparison by Offer
v Offer Response Breakout
v Offer Response Rate Comparison
v Offer Responses for Last 7 Days
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Before you contact IBM technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company's designated support contact can log a call with
IBM technical support. Use these guidelines to ensure that your problem is
resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
administrator for information.

Note: Technical Support does not write or create API scripts. For assistance in
implementing our API offerings, contact IBM Professional Services.

Information to gather

Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages that you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM technical support, you might be asked to provide information
about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, check for a version.txt file that is located under the installation
directory for your application.

Contact information for IBM technical support

For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.ibm.com/support/entry/portal/open_service_request).

Note: To enter a support request, you must log in with an IBM account. This
account must be linked to your IBM customer number. To learn more about
associating your account with your IBM customer number, see Support Resources
> Entitled Software Support on the Support Portal.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
B1WA LKG1
550 King Street
Littleton, MA 01460-1250
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
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platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations
IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."
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